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In the notes which follow:
•
•
•

General comments are printed in normal text such as this;
Keywords or terms are printed in bold text;

Instructions are in a grey box. You should carry out the instructions contained in boxes such
as this
Further comments or handy “tips” are in italics in a smaller size with a line at the left and the right such as
this

When the instructions refer to something like “Select File > Save” this means to move your
mouse until it is pointing at the word File at the top of the screen on the Menu Bar and then
to click the left mouse button once. Then, point at and click the word Save from the list
which drops down.
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Basic Principles
Getting Started - Orienting the SMART Board
Orientation ensures your touch is registered accurately when you are using the SMART Board
interactive whiteboard. If you press the interactive whiteboard with your finger and your
cursor appears somewhere other than where you are pressing, try orienting the interactive
whiteboard.
1. Open the SMART Board Tools by double clicking on the SMART
Board Tools icon
. This is on the light blue bar at the bottom
right-hand corner of the screen (or it may be on your desktop).
2. Click on Orient on the SMART Board Tools.
3. The screen below will appear: either use your finger or one of the
pens to carefully tap the centre of each cross as it appears on the
screen. (Care taken at this stage will prove advantageous when
using the board). Once this is completed the Orient screen will disappear.
4. An alternative way to orient the board is to simultaneously hold the keyboard and mouse
buttons down on the pen tray on the SMART Board
Please note this process needs to be completed at least once a day in order for the SMART Board to retain its
accuracy.

If the SMART Board Tools icon is not there, click on Start > All Programs > SMART
Board Software > SMART Board Tools. If the Orient button is greyed out, check that your
SMART board is connected.
The Orient button will appear as greyed out unless the computer is attached to a SMART board.
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My SMART Board won’t work!
There may be occasions when you have connected the SMART Board to the computer, yet
the orient button is still greyed out. There are several options you might try:
• A green light should be visible on the bottom right corner of the board. Firstly check
the cables are correctly connected to the back of your computer and to the projector.
• Click on the SMART Board Tools icon and choose Control Panel > SMART Board
Connection Wizard. A window will appear, choose Connect the SMART product to
your computer > Next button. Look at the picture of the cables, check that you have
connected your cables correctly and then click on Next. The computer will scan for the
software and connect.
• If you do not have a USB SMART Board, check that the small cable is connected to the
keyboard port as this supplies the power to the SMART Board if you are not using a
USB connection.
• If all else fails ensure the cables are all connected and then restart the computer.
Using the SMART Board as a computer
The board can now be operated as a computer with your finger acting as a mouse. In this way
you can run any program that is installed and any files you create on the SMART Board are
stored on the computer. The whiteboard is just a large screen; it does not store any
information.
• A tap with your finger has the same effect as a left mouse click.
• Two taps on the board in quick succession is the equivalent of a double click
• You can drag a window around the screen by holding your finger on an active (blue)
title bar.

___________________________________________________________________________
2

___________________________________________________________________________
The Start Centre
Click on the SMART Board Tools icon on your desktop and the Start Centre will be
launched. This is a toolbar that has quick start buttons for the most frequently used SMART
Board features.
Launches SMART Notebook

Launches Floating Tools

Launches SMART Recorder

Launches Control Panel

Launches SMART Video Player

Launches SMART Board Software
Help Centre

Launches On-Screen Keyboard

More Buttons

The ‘More Buttons’ option also enables you to Orient the SMART Board

Getting to know SMART Notebook
SMART Notebook is SMART’s whiteboard software. It acts as an electronic notebook to
immediately capture and save notes and drawings written on the SMART Board interactive
whiteboard or at your desktop computer, which you may not easily be able to do with other
applications such as Microsoft Word or PowerPoint for example.
You can freely download the SMART Board software which includes SMART Notebook if
you have SMART Boards installed in your school. Visit http://www.smarttech.com then
select the Support link in order to select the applicable download.
Launch SMART Notebook from the Start Centre or by using the icon on your desktop and
then use the guide on page 4 to familiarise yourself with its functionality.
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Smart Notebook Toolbar

Display the previous Notebook page

Select any object on the page

Display the next Notebook page

Pen tool

Insert a blank page

Creative pen tool

Open a Notebook file
Erase annotations
Save your file

Draw a line

Paste

Create a shape

Undo the last action you performed

Create a text-entry box

Redo the last action you performed

Set the current colour of a tool, shape or
object

Delete any selected object(s)

Set the transparency of a tool or object

Show/hide the screen shade

Select the line width of a tool or object

Launch full screen view

Move the toolbar to the bottom of the screen

Launch the capture tool

___________________________________________________________________________
4

___________________________________________________________________________
Creating a simple word sort using SMART Notebook
(See figure 3 on page 6)
1. Select the create a shape icon from the toolbar and click on the small black
arrow pointing downwards.
2. Choose the Circle option by clicking on it and draw a circle on the page either by
pressing and dragging your finger on the SMART Board or by using the left mouse button
on your computer.
3. Select the Arrow/Select tool from the centre of Notebook toolbar so that you
do not continue to draw more circles.
4. Click on the edge of the circle so that it is surrounded by a frame (see fig.1 below) then
select the small down arrow (drop-down box) at the top right hand corner of the frame
(see fig.2). Select the Clone option to make an exact copy of your original circle
If your circle is not quite the right size or shape then select the circle by clicking on its edge
and use the small white circle at the bottom right hand corner of the frame to adjust the
length or width. Click Undo on the toolbar to remove any additional unwanted circles you
may have created.

Figure 1

Figure 2

5. Click on the circle and drop-down box once more to reveal the menu in fig.2. Select the
Properties option and then select the applicable Outline and Fill colour that you require.
Repeat this with the other circle.
6. Next, select the edge of the circle once more and choose the Lock in Place option. This
prevents the circle from moving during the word sort activity with the pupils.
Locking can be reversed by clicking on the circle and clicking on the small padlock that appears.
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7. Change the background colour of your Notebook page since white pages are very stark
for pupils to look at. Select Format from the Toolbar and then Background Colour.
Select an appropriate colour for your classroom based on whether your classroom has
bright sunlight or blinds for example.
Current research suggests that very dark backgrounds with light writing or pastel shades improve this.

8. Finally, add the words you wish to use in your word sort. Click on the dropdown box beside the Text Box icon
9. Use the Customise option to set the text to the style, size and colour you require.
10. Click on a blank space in your Notebook and type the first word using your keyboard.
Click on another blank space in your Notebook to complete the word and therefore
allow it to move independently from any others that you type. Move you mouse to a
new space and type the next word. Click on a space in your Notebook to complete the
word and continue until you have all the words you require.

Figure 3
The Object Drop-Down Menu
To activate this menu, select the object and click on the arrow in
the top right-hand corner. A menu will appear that has the
following options.

Figure 4
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Clone

Make an exact copy of the selected object

Cut

Remove the selection from the current Notebook and place it on the clipboard

Copy

Copy the selection from the current Notebook and place it on the clipboard

Paste

Insert the contents of the clipboard into the Notebook

Delete

Delete the selection from the Notebook

Check Spelling

Check the spelling of a selected text box

Lock in Place

Lock the selected object to the background. There are three locking options:
•
•
•

to lock it completely
to lock it but allow it to move but not re-size, flip or rotate
to lock it allowing it to rotate but not re-size.

Grouping

Group and Ungroup objects

Flip

Flip images either vertically or horizontally

Order

Changes which objects are in front of or behind other objects

Infinite Cloner

Setting an image with this property means that users can drag infinite copies from the
top of the existing one

Link

Add a link to a website or file. In this way, for example, PowerPoint files can be
embedded seamlessly. Links can also be made to different pages of the Notebook.

Sound

Add a sound to an image or text

Properties

Modify the properties of an object e.g. changing the Font or Text Colour

Grouping
Objects can be grouped together for ease of moving them around the screen. You may wish to
do this, for example, if you have created a maths puzzle or sorting activity where you require
an image and text to move simultaneously.
1. Hold your left mouse button down (or use your finger on
the board) and drag a box to surround the objects/text
you wish to group; you should see two frames – one
around the text and another around the image.
2. Select one of the drop-down boxes of either of the selected
objects.
Figure 5
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3. Choose Grouping from the menu and then Group. This will ensure the objects you have
selected move as one group.
4. You can ungroup objects by selecting Grouping and then Ungroup.

Locking objects to the background
Objects can be locked to the background to prevent them being moved around the screen.
This can also prevent objects from accidentally being moved which is especially useful if you
are dragging numbers or words onto a shape you have already drawn, for example the light
blue rectangle in figure 5.
1. Select the object or objects that you wish to fix to the background by clicking on it/them
in order to reveal the frame.
2. Click on the object’s drop-down menu at the top right hand corner of the frame and
choose Lock in Place.
3. To unlock an object, click on the object once again and click on the padlock icon
choose Unlock Annotation.

and

Resizing and rotating an object
Once you have drawn a shape or copied one from the gallery, you may find that you wish to
resize or rotate it.
1. Click on the object until the object frame appears (see fig.1 on page 5). At the bottom
right of the select box a white circle will appear. Place your finger or mouse on the white
circle. Drag the object to the size you require.
2. The small green circle at the top of the shape allows you to rotate the shape. Click on the
green circle, then rotate the object to the required position.
3. To flip an item, click on the object and select flip from the object drop-down menu.

Infinite Cloner
This is another extremely useful function of SMART Notebook. Instead of having to use
copy and paste in order to make multiple copies of a particular object, infinite cloner creates
an infinite pile of a selected object. This can be useful if you have created a word sort where
___________________________________________________________________________
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you need multiple copies of a prefix to match with a root word for example, or in a maths
notebook where you need piles of coins in order to investigate how many ways you can make
a total of 25p.
1. Insert (or type if using words) one of the objects you wish to make infinite copies of.
2. Click on the object in order to reveal the object drop-down box.
3. Select the infinite cloner option and although the object will look no different, if you
remove the top object from the pile, another will be revealed.
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Other Features of SMART Notebook
Using the show/hide screen shade
This is particularly useful to reveal small amounts of text during shared reading, or to hide
maths problems to ensure the children remain focussed on the section you are teaching.
1. Click on the Screen Shade icon on the toolbar. Drag the shade down or across,
depending on the desired outcome.
2. To remove the shade, click on the screen shade icon once again.
A screen shade can be added to individual pages of your Notebook file whilst it is being created so that pupils
cannot see what is coming until it is revealed.

Drawing and filling shapes
There is a wide selection of shapes that you can add to your notebook page. These can be
accessed by clicking on the Shape button.
1. Click on the drop-down box next to the Shape icon and choose the shape you want.
2. Draw the shape in the notebook. Click on the Select icon in order to prevent drawing
additional unwanted shapes. If you then want to fill the shape click on the
shape to select it and choose the Line and Fill Colour icon from the top
toolbar.
3. This will bring up two colour menus, one for the line colour and one for the fill colour
from which you can select the appropriate colour.
Selecting and changing pens
You can either click on the Pen icon or the Creative Pen icon to select pens to use. The Pen
icon allows you to choose from normal pens to those created by arrows and dots. You can
also customise your pen by clicking on the Customise button at the bottom of the list. This
will allow you to choose the exact properties that you want. This is a particularly useful tool
should you wish to block out specific words in a text, then use the eraser to reveal them (see
page 17 for more details). With the Creative Pen icon you get access to seven different, fun
pens.
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Creating a Magic Box!
In order to become more familiar with some aspects of SMART Notebook contained in this
booklet, you may wish to try this task. In this activity, Guess my Rule, set the order of the
numbers allowing some to go ‘into’ the magic box and others to stay outside of the box. This
can be adapted to other areas of the curriculum, for example sorting words or phrases with
apostrophes; those that go into the box have an apostrophe for contraction, those that stay
outside of the box have an apostrophe for possession or to sort images of natural and man
made materials, for example.

Figure 6

1. Start by changing the background to your Notebook page. Choose Format from the
toolbar then Background Colour.
2. Create a rectangle using the shape icon
page 5.

and fill it according to the instructions on

3. Lock it to the background using the instructions on page 8.
4. Use the text box tool to create an appropriate title for your Notebook.
5. Next, customise the text box tool to the colour you require the numbers – in this example
it is set to Times New Roman, size 36, bold and yellow.
6. Type the first number you wish to have on your page and then click on a space to enable
it to move independently of any others that you type. Repeat this process until you have
all the numbers on the page.
Next we need to Set the Order so the numbers you wish to go into the box are set to Go to
the Back and hence will disappear ‘into’ the box.
7. Click on the select arrow in order to stop creating more text boxes.
___________________________________________________________________________
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8. Click on the first number that you wish to go into the box, then hold the control key
(Ctrl) on your key board before clicking the next number you wish to set to go into the
box and click on the next and so on. Once you have selected all of the numbers that you
wish to go into the box, release the Control key.
9. Choose any of the drop-down boxes of the numbers that have been selected and select
Order. Then from the menu that appears choose Send to Back. Save your file.
Nothing will appear to happen until you click on a blank space on your page and drag one of
these numbers into your magic box. It should go ‘into’ the box. If you try this with one of
the other numbers it should not go onto the box, allowing you to ask the pupils which
numbers will go into the box? Can you suggest another that might go into the box? Then,
once they have been sorted ask what is the rule being applied here?
To retrieve the numbers from the box select the undo button from the toolbar

Once you have set up one of these activities, the page can be cloned to enable you to alter the
numbers and repeat the activity without having to recreate the entire page.
10. In the slide sorter on the side of the page, click on the small drop-down box at the top
right hand corner of the page where you created your magic box (see figure 7).
11. Select Clone Page. This will produce an exact copy of the page enabling you to change
the numbers and have a new set of criteria by which to sort the numbers.

Figure 7

Using the Screen Capture Tool
This is especially useful to capture parts of web pages for shared reading
or to retain annotations you have made over a specific area of the screen.
This is effective, for example, in mathematics if you wish to save some
of the work created in your whole class teaching and are in danger of
losing the annotations. You can either capture the whole screen or a
specific part of it. There is also a freehand selection so that any shapes can be captured.
1. Launch the screen capture tool by clicking on the icon on the toolbar.
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2. Minimise SMART Notebook so you can see the area you wish to capture. Select the area,
window, screen or freehand option. If you are using the area tool, move the camera to the
part of the object you wish to capture.
3. Drag it to surround the area you wish to capture. This will save the objects to a new page
in the SMART Notebook.

Inserting images into SMART Notebook
There may be occasions when you wish to add an image to your Notebook, or it may be that
your Notebook page is based on the sorting of objects, for example sorting natural or man
made materials or sorting 2D and 3D shapes. There are several options available to you
including using the screen capture tool above.
Importing pictures from other applications
1. Find the image on the Internet or in a file you have previously created, right click your
mouse on the object and select copy.
2. Open SMART Notebook and then right click your mouse and select paste or select paste
from the toolbar.
When you copy an image in this way, you may have a white border around the object or parts
of the object that you wish to make transparent.
3. Click on the object to reveal the drop-down box menu. Select Set Picture Transparency
from this menu and then use the colour dropper to select the areas you wish to be
transparent.
Alternatively you may wish to select an image from SMART Notebook’s Gallery.

Using the SMART Notebook Gallery
There is a selection of templates and pictures in the gallery that can be inserted into your
Notebook.
1. Open the Gallery by clicking on the Gallery tab on the right hand side of the screen.
You will see three windows. The top window is a search box where you can type the subject
you are looking for. The gallery will return any suitable results it may find.
The second window is used to navigate to the collection that you need.
___________________________________________________________________________
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2. Click on the small + sign to the left of the words Essentials for Educators. This will
expand the gallery and reveal the subheadings e.g. Geography, History and Mathematics.
3. Click on the small + sign to the left of the sub heading and it will reveal further headings,
for example if you click on Geography, Flags, Landscapes and Maps will be revealed. By
clicking on the heading you will see a bank of clip art in the bottom pane.
4. Once you have selected a particular image, click and drag it from the right hand pane onto
the page in your Notebook. This object can be resized or rotated by clicking on the
object and selecting the small white circle at the bottom right hand corner to resize or the
green circle at the top of the frame to rotate it.
5. Do remember to close the sub headings in the gallery by selecting the small – sign beside
each one, otherwise it can look confusing the next time you open it.
There are three different types of images in the gallery:

Figure 8
A template – the entire
background will be filled
with this picture and
although you can add images
from the gallery, you won’t
be able to move any elements
of the template.

A flash file – this is an
animated file parts of which
will move when you select
them.

Images that can be
independently inserted into
your Notebook

Creating your own Gallery collection
The final heading in the top window of the Gallery tab is called My Content. You can use
this area to add images that you use regularly hence avoiding searching the gallery each time
or to create your own collections.
1. Select My Content from the Gallery and choose the drop down box to the right hand side
of the words My Content.

___________________________________________________________________________
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2. Select Add Folder from the menu and give it an appropriate name. For example, if you
are going to add resources you might use regularly in mathematics then call this folder
maths resources.
3. Browse the gallery in order to select and drag any resources onto a new page in your
Notebook.
4. Once you have the images in your Notebook, close the Gallery sub headings using the –
sign and click on My Content. Select the folder which you created and drag the images
from the Notebook page onto the blank pane below the Gallery menu where you have
been searching. Repeat this with all the images you require and this will add those images
you have selected to the My Content folder. This will save you time when creating
resources in the future.
Additional Tools and Techniques
Floating Tools
The Floating Tools provides an optional toolbar that gives you access to tools that
you may need to use quickly. It floats over any open application on your interactive
whiteboard and can be accessed by clicking on the SMART Board Tools icon and choosing
Floating Tools.
The floating tools can be modified to show whichever icons you prefer.
1. Launch your Floating Tools and click on the Options button.
2. A drop-down menu will appear, choose Customise Floating Tools.
A window will appear. The icons that you have on your Floating Tools are shown on the
right and those available to you are shown on the left.
3. Click on an icon that you want to appear on your Floating Tools and click on Add.
You can move the position of the icons as they appear on the Floating Tools, by clicking on
the icon and choosing Move Up or Move Down.
Retaining annotations made on the SMART Board
Any annotations you make with the SMART Board pens will be retained if you are working
in SMART Notebook. These can be erased, added to or altered as required. However if you
annotate a Word document, a page from the Internet or a maths program, for example, the
annotations often disappear when you touch the SMART Board again, which can be
frustrating.
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These annotations can be restored on your SMART Board enabling you to review, or add to
them.
1. Click on the SMART Board Tools icon and choose Floating Tools [when connected to
your SMART Board]. A collection of floating tools appear that will remain on the screen
even when you open Word or the required application.
2. Make the annotations you wish and continue working until the annotations disappear
because you have clicked the SMART Board or scrolled the page, for example.
3. Select the Restore Cleared Page option from the floating tools
which will restore the annotations you have made. You can
then add to these annotations and repeat this process as required.
Spotlight
One of the more interesting features available on the Floating Tools is the Spotlight. Use the
Spotlight to draw attention to a particular area of the screen. You can move the spotlight to
different areas of the screen, change its shape, remove it entirely and make its background
transparent.
You may wish to display a picture in an art lesson and concentrate what the pupils can see.
Alternatively you may use it in a history lesson to focus pupils’ attention on portraits and
what they reveal about the subject.

1. To launch the Spotlight either select the SMART Board Tools icon from the desktop or
from the Start Centre then select the more buttons icon (see page 3 for details).
2. Select Spotlight from the menu.
3. To make the spotlight larger or smaller, or to change the shape's proportions, press the
edge of the blue area around the spotlight, and drag the shape to the size you want.

___________________________________________________________________________
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4. To change the background transparency, press the drop-down arrow on the spotlight
icon, select Transparency and select the degree of transparency you want.
5. To move the Spotlight click on the spotlight symbol and drag to the required position.
6. To remove the Spotlight with Spotlight open, press the Menu button. Select Exit or Esc
on your keyboard.

Blocking Out
There may be occasions when you wish to reveal
some hidden text as part of your teaching but block
out other parts. For example in a shared text all of
the adjectives may have been removed, or in a
spelling investigation the prefixes hidden. There
are two ways this can be achieved:
Create a rectangle to cover up specific words or
phrases (see page 10 for drawing and filling shapes)
Alternatively you may wish to use the ‘white-out’ option. This allows you to remove the
selected word or phrase by colouring over it using a pen that has been set to the same colour
as the page background. The board eraser will reveal the hidden text when rubbed over it.
In this example the prefixes have been removed using the white pen tool. When the board
eraser is rubbed over them, the prefix will be revealed.
1. Click on the drop-down box beside the Pens and Highlighters icon on the toolbar in
Notebook and select Customise Pens and Highlighters.
2. Select white from the colour options (or the select same colour as the page background)
and change the width of the line by selecting a thick line from the Line Thickness option.
3. Finally colour over the word or phrase with the pen and the word will ‘disappear’.
4. When using this page of your Notebook, once the children have recorded their
predictions, use the board eraser to remove the ‘white-out’ and repeat with the next
example.

___________________________________________________________________________
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Magic Paper
This is a versatile technique that can be used in a wide range of curriculum contexts. In these
examples a teacher used it in modern foreign languages or in a literacy lesson. When you drag
an object onto the magic paper, additional information will be revealed.

1. Insert the words and/or images onto the page e.g. type ‘horse’ on one line, press enter and
type ‘le cheval’ on the next line in the same text box.
2. Highlight the word ‘horse’ and using the mouse, change the colour to a lighter one using
the toolbar that appears.
3. Highlight the ‘le cheval’ text and change the colour to the same as you intend the
background to be – in this case purple. Once the background is set to the same colour
purple, the word ‘le cheval’ will be hidden.
4. Finally, group the text with images if applicable (see page 7)
5. Set the background colour to the same as the text you wish to ‘hide’ by selecting Format
and Set Background Colour.
6. To create the ‘magic paper’ draw a rectangle using the shapes tool and colour it (see
drawing and filling shapes on page 10).
7. Ensure the rectangle is ‘sent to the back’ by clicking on it, then selecting the drop-down
box and select Order. Then, from the menu which appears, choose Send to Back. Save
your file.
8. Finally Lock the ‘magic paper’ to the background.
When you move one of the objects/words from the Notebook page onto the magic paper the
hidden information will be revealed.

___________________________________________________________________________
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Dragging words, images or phrases from one page to another
This technique is particularly useful if you need to reorder pictures or words from one page to
another. In this example the images display the process of pollination.

Having watched a short video clip [www.brainpop.com] the pupils take notes to assist their
understanding. The teacher reorders the images on different pages of the Notebook according
to the pupil’s notes. Then the notes are recorded beside the appropriate image.

1. Select the word or image on the page you wish to move to another page.
2. With your finger (or mouse) drag it onto the page within the slide sorter and let go
The word or image should have been moved to this new location.
3. Click on the page in the Slide Sorter to check this has been achieved.

___________________________________________________________________________
19

___________________________________________________________________________
Planning a lesson using multiple pages
As mentioned before you can create many pages within one Notebook file.
In this way you can plan lessons away from the SMART Board as the information is stored on
the computer and when you reconnect it SMART Notebook will be displayed on your
SMART Board.
Page order can be rearranged if you wish. Click on the slide you wish to move [in the Slide
Sorter]. Then drag it to the new position either above or below its current position in the
Notebook. A blue bar will appear indicating where it will be positioned.

SMART Notebook Help
The in-built help files are comprehensive and very easy to use.
1. In SMART Notebook click on Help from the toolbar and choose Contents.
You can either browse through the contents pages to find more information or use the search
box at the right hand side of the screen to type in search terms.
You may have to click on the yellow bar just below the menu bar to allow active content

___________________________________________________________________________
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Advanced Techniques
Attaching a sound
You can attach a sound file to any Notebook object. You may wish to do this to accompany a
piece of atmospheric writing or a game: what animal or instrument am I? You could display
an image of a story setting and ask pupils to record how they would feel if they found
themselves in the middle of the setting. Then play a sound, perhaps a howling wolf, and ask
how this changes their perception of the setting. There are many websites that contain free
sound files. Oxfordshire now has an Audio Network Schools Licence for all Oxfordshire
Schools through the National Education Network and Regional Broadband Consortia; visit
http://audio.lgfl.org.uk/
The National Education Network (NEN) can only be accessed from within the OCN, i.e., from schools.

1. Select the object to which you wish to attach sound and
click the drop-down menu.
2. Select sound from the menu. Browse to the sound file that
you want to insert, and press Open.
Note that Notebook supports .mp3 format
3. Preview the sound by pressing Play.
4. Select either Corner icon or Object to establish the way
the sound should be played (see fig.9).
5.

Press OK.

Figure 9
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Importing video clips into your notebook
It is possible to embed video clips into a SMART Notebook and then resize or rotate them.
If you are embedding a Flash Video file
1. Open a Notebook.
2. Select Insert > Flash Video File.
3. Browse to the video file that you want to insert and press Open.
If you are inserting other video formats
Notebook only supports .flv files for video formats hence you will need to convert videos to .flv format using
“Media Coder”. The MediaCoder 0.3.9 converts .aif, .aiff, .wav .asf, .avi, .mov, .mpeg, .mpg, .wmv to .flv
format.

1.

Download and install Media Coder from: http://mediacoder.sourceforge.net/

2. Open the program and click on Add file
3. Browse to select the file that needs converting
4. Highlight it in the box so that it is selected
5. Click on the Video tab at the bottom left hand side of the box and change the Codec and
Format to Flash Video
6. Click on the Start button from the menu icons in the Media Coder dialogue box. A
message will appear explaining that transcoding is completed. Click OK.
7. Click on File > Save current settings and the converted file will appear in the same
folder as the original.
8. Navigate to the folder to find the converted file which will now be saved as a .flv file. This
can be imported into a SMART Notebook using the instructions above.
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Using Smart Video Player to play videos

The Smart Video Player is a tool for viewing and annotating video clips and graphics. You can
use it with standard video files or the output from video hardware which is connected to your
system.
The difference between SMART Video Player and Windows Media Player or Real Player, is
that the SMART Video Player will allow you to annotate over still or moving video when
your laptop is connected to your Smart Board. Any annotations you make can then be
cleared or captured to the SMART Notebook software.
1. Launch SMART Video Recorder either via the Start Centre or SMART Tools.
2. Select File > Open and navigate to where your video is stored.
3. As soon as the video is loaded it will begin to play. You can pause it using the pause
button at the bottom left hand corner of SMART Video Player or by removing one of the
pens from the tray on the SMART Board.

Annotating the video

Smart Video Player detects when a pen or the eraser has been
removed from the tray at the front of the Smart Board.
Every time you wish to make a note about the video on the
SMART Board, pick up a pen from the tray; the video will
automatically stop allowing you to make annotations. When
you replace the pen, the video will restart.

The annotations you make can be saved into Smart Notebook for you to use at another time.
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Cursor Set Pen Colour

Play/pause Stop
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Full screen

Increasing the size of the video on the screen

There may be times when you want to increase the size
of the video clip. Selecting options and view from the
toolbar will give you the choice of 100% (which is the
default size) or 200% as in this example. Clearly this
gives you less room to annotate or make notes.

Note this is subject to the age of the hardware you are using. Some images may be distorted if you increase
the size to 200% on some older laptops.

SMART Recorder
SMART Recorder captures everything that happens on the SMART Board, no matter which
software application you are using. Recorder can also record audio through a microphone and
then combine the audio and data into one file for playback on any computer. Anyone with
Windows Media Player can play the file back and watch it like a movie. For example if you
are using a series of resources to demonstrate a concept in mathematics, Recorder will retain
the individual steps that you used in the form of a video with sound.
1. Launch SMART Recorder either via the Start Centre or SMART Tools
A menu will appear and once you have agreed to the Licence Agreement the menu will become enabled.

2. This menu ‘floats’ on top of all applications that you may have open and once the red
button has been pressed, all actions that take place on your computer screen or SMART
Board will be recorded until you select the small blue square ‘stop’ button. In addition
any audio is recorded via your computer’s microphone.
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3. Once you selected the stop button your file will be saved to your My Documents folder.
Give it a file name and SMART will convert the audio and visual to an .avi file and will
ask if you wish to replay the file.
Do note that SMART Recorder files can become quite large if they are recording for long periods of time.
You may be able to reduce this. Visit http://www2.smarttech.com/kbdoc/77804 for more information.
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